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To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

To select a line of text, select the first letter of the sentence or phrase and drag to
the last letter.

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option
(Mac OS) as you drag across the width of the document.

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command
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in the document is selected. When you release the mouse button, the selected text is
highlighted. To deselect the text and start over, click anywhere outside the selected text.
The Select All command will not select all the text in the document. A workaround for this
(Windows) is to use the Edit > Copy command. Choose Edit > Copy to copy the selected
text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the
Show Clipboard command until it is installed. To install the Clipboard Viewer, Choose
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows
Setup tab. Double-click Accessories, check Clipboard Viewer, and click OK.
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[REPORT OF ACTION TAKEN IN CLOSED SESSION ON

TUESDAY MARCH 20,2007 BEGINS ON PAGE 158.]

SUP. YAROSLAVSKY, CHAIRMAN: THE BOARD OF SUPERVISORS MEETING
WILL COME TO ORDER. ASK EVERYONE TO RISE FOR THE INVOCATION
AND THE PLEDGE OF ALLEGIANCE. THE INVOCATION WILL BE LED BY
JASON BROWN, THE DIRECTOR OF YOUTH-- I'M SORRY, OF YOUNG ADULT
MINISTRIES AT THE EMMANUEL REFORM CHURCH IN PARAMOUNT AND THE
PLEDGE WILL BE LED BY OUR OWN JOSEPH SMITH, THE DIRECTOR OF

THE DEPARTMENT OF MILITARY AND VETERANS AFFAIRS. MR. BROWN?

JASON BROWN: LET US PRAY. DEAR GOD, MAY YOUR PRESENCE AND YOUR
HOPES AND YOUR VERY BEING BE GLADLY ESTEEMED, EVEN LOVED.
PLEASE BRING YOUR VISION OF HOW WE SHOULD LIVE AS HUMAN BEINGS
IN RELATIONSHIP TO EACH OTHER AND TO YOU TO REALITY. PLEASE
LEAD US TO LIVE IN A WAY THAT REFLECTS WHAT IS ETERNALLY GOOD.
PLEASE BRING THE HEALING AND LIFE-FULLNESS OF HEAVEN TO THE
PEOPLE AND COMMUNITIES OF LOS ANGELES COUNTY. GIVE US AND
THESE SUPERVISORS EVERYTHING WE NEED TO SUSTAIN A WAY OF LIFE
THAT IS DEEPLY COMPASSIONATE, EXTRAVAGANTLY GENEROUS,
KNOWINGLY HUMBLE AND WHOLLY INTEGRATED. FORGIVE US AND GRANT

US THE GRACE AND SELF-AWARENESS TO FORGIVE OTHERS. PLEASE
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1 PROTECT US FROM SELF-DELUSION AND SELF-CENTEREDNESS AND POWERS
2  BEYOND OUR CONTROL THAT WOULD STEAL OUR HEART AND KILL OUR

3 SOULS. WATCH OVER US IN MERCIFUL LOVE. AND WE PRAY THESE

4 THINGS NOT BECAUSE IT'S TECHNICALLY PROPER NOR OUT OF

5 FUNCTIONAL OBLIGATION BUT BECAUSE YOU HEAR AND YOU HAVE VISION
6 FOR OUR LIVES TOGETHER AND YOU HAVE THE POWER AND DESIRE TO

7 REALIZE THIS VISION AND BECAUSE WE, WHETHER AT OUR BEST AND

8 MOST INDEPENDENT OR AT OUR WORST AND WEAKEST, DESPERATELY NEED
9 YOU. AMEN.

10

11 COL. JOSEPH SMITH: PLEASE PLACE YOUR RIGHT HAND OVER YOUR

12 HEART AND JOIN ME IN THE PLEDGE OF ALLEGIANCE TO OUR NATION'S
13 FLAG. [ PLEDGE OF ALLEGIANCE ]

14

15 SUP. YAROSLAVSKY, CHAIRMAN: SUPERVISOR KNABE.

16

17 SUP. KNABE: THANK YOU, MR. CHAIRMAN, MEMBERS OF THE BOARD,

18 LADIES AND GENTLEMEN. IT'S MY HONOR TO PRESENT A CERTIFICATE
19 OF APPRECIATION TO MR. JASON BROWN. AS WAS MENTIONED, HE IS

20 THE DIRECTOR OF YOUNG ADULT MINISTRIES AT EMMANUEL REFORM

21 CHURCH IN PARAMOUNT. HE LED US IN THE INVOCATION THIS MORNING
22 AND THAT'S THE CHURCH THAT MY WIFE AND I ATTEND AND WE'RE JUST
HONORED TO HAVE JASON HERE. HE'S A RECENT MEMBER OF THE STAFF
THERE COMING FROM COLD IOWA TO THIS WARM SUNNY SOUTHERN

CALIFORNIA, VERY HAPPY TO BE IN SOUTHERN CALIFORNIA RIGHT NOW.
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1 HE, AS I MENTIONED, IS A LIFETIME RESIDENT OF IOWA. HE AND HIS
2 WIFE, EMILY, MOVED TO PARAMOUNT THIS PAST JULY WITH THEIR TWO
3 SONS, JOE, AGE 4, AND JACK, AGE 2, TO BE PART OF OUR GREAT

4 EMMANUEL FAMILY THERE. WE WELCOME HIM HERE BUT ALSO TO EXTEND
5 A HEARTFELT THANKS FOR LEADING US IN THE INVOCATION AND LOOK

6 FORWARD TO SEEING HIM SOON, LIKE SUNDAY. [ APPLAUSE ]

8 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. THANK YOU, JOSEPH, FOR
9 LEADING US IN THE PLEDGE OF ALLEGIANCE. COULD WE HAVE THE

10 AGENDA, SACHI?

11

12 CLERK SACHI HAMAI: GOOD MORNING, MR. CHAIRMAN, MEMBERS OF THE
13 BOARD, WE WILL BEGIN TODAY'S AGENDA ON PAGE 6, AGENDA FOR THE
14 MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEM 1-D.

15

16 SUP. YAROSLAVSKY, CHAIRMAN: HANG ON A SECOND. I CAN'T FIND

17 PAGE 6. MS. MOLINA MOVES, MR. KNABE SECONDS. UNANIMOUS VOTE.
18

19 CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE HOUSING

20 AUTHORITY, ITEMS 1-H THROUGH 3-H. ON ITEM 1-H, THE EXECUTIVE
21 DIRECTOR OF THE HOUSING AUTHORITY REQUESTS THAT ITEM BE

22 CONTINUED ONE WEEK TO MARCH 27TH, 2007.
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1 SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, THAT WILL BE
2 THE ORDER. ON THE REMAINDER, BURKE MOVES, MOLINA SECONDS.

3 UNANIMOUS VOTE.

5 CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE REGIONAL PARK
6 AND OPEN SPACE DISTRICT, ITEM-- ON ITEM 1-P, THE DIRECTOR OF
7 PARKS AND RECREATION REQUESTS THAT THIS ITEM BE REFERRED BACK

8 TO HIS DEPARTMENT.

10 SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, THAT WILL BE
11 THE ORDER.

12

13 CLERK SACHI HAMAI: BOARD OF SUPERVISORS, ITEMS 1 THROUGH 9. ON
14 ITEM NUMBER 9, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC
15 TO HOLD THIS ITEM.

16

17 SUP. YAROSLAVSKY, CHAIRMAN: WE WILL HOLD IT.

18

19 CLERK SACHI HAMAI: THE REST ARE BEFORE YOU.

20

21 SUP. YAROSLAVSKY, CHAIRMAN: KNABE MOVES, BURKE SECONDS.

UNANIMOUS VOTE.

CLERK SACHI HAMAI: CHIEF ADMINISTRATIVE OFFICER, ITEMS 10

THROUGH 16. ON ITEM 10, THE CHIEF ADMINISTRATIVE OFFICER IS
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1 REQUESTING THAT THIS ITEM BE REFERRED BACK TO HIS DEPARTMENT.
2 ON ITEM 11, AS INDICATED ON THE POSTED AGENDA, THE DIRECTOR OF
3 CHILDREN AND FAMILY SERVICES REQUESTS THAT THIS ITEM BE

4 CONTINUED TWO WEEKS TO APRIL 3RD, 2007. AND ON ITEM 12,

5 SUPERVISOR MOLINA REQUESTS THAT THIS ITEM BE CONTINUED ONE

6 WEEK TO MARCH 27TH, 2007. ITEMS 13 THROUGH 16 ARE BEFORE YOU.

8 SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, ITEM 10 WILL BE
9 REFERRED BACK TO THE C.A.O. 11 WILL BE CONTINUED FOR TWO WEEKS
10 AND 12 WILL BE CONTINUED FOR ONE WEEK. ITEMS 13 THROUGH 16,

11 MS. BURKE MOVES, MR. KNABE SECONDS. UNANIMOUS VOTE.

12

13 CLERK SACHI HAMAI: AGRICULTURAL COMMISSIONER/ WEIGHTS AND

14 MEASURES, ITEM 17.

15

16 SUP. YAROSLAVSKY, CHAIRMAN: MOLINA MOVES, KNABE SECONDS.

17  UNANIMOUS VOTE.

18

19 CLERK SACHI HAMAI: ARTS COMMISSION, ITEM 18.

20

21 SUP. YAROSLAVSKY, CHAIRMAN: BURKE MOVES, KNABE SECONDS.

UNANIMOUS VOTE.

CLERK SACHI HAMAI: CHIEF INFORMATION OFFICE, ITEM 19.
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1 SUP. YAROSLAVSKY, CHAIRMAN: KNABE MOVES, MOLINA SECONDS.

2 UNANIMOUS VOTE.

4 CLERK SACHI HAMAT: COMMUNITY DEVELOPMENT COMMISSION, ITEM 20.

6 SUP. YAROSLAVSKY, CHAIRMAN: KNABE MOVES, BURKE SECONDS.

7 UNANIMOUS VOTE.

9 CLERK SACHI HAMAI: DISTRICT ATTORNEY, ITEMS 21 AND 22. ON ITEM
10 22, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE DISTRICT

11 ATTORNEY REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO

12 APRIL 3RD, 2007.

13

14 SUP. YAROSLAVSKY, CHAIRMAN: WITHOUT OBJECTION, THAT WILL BE
15 THE ORDER. ITEM 21, KNABE MOVES, MOLINA SECONDS. UNANIMOUS

16 VOTE.

17

18 CLERK SACHI HAMAI: HEALTH SERVICES, ITEMS 23 THROUGH 28. ON
19 ITEM 23, THIS RECOMMENDATION WAS REVISED AS INDICATED ON THE
20 SUPPLEMENTAL AGENDA AND THERE IS ALSO A REQUEST FROM A MEMBER

21 OF THE PUBLIC TO HOLD THIS ITEM.

SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. WE'LL HOLD IT.

CLERK SACHI HAMAI: AND 24 THROUGH 28 ARE BEFORE YOU.
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2 SUP. YAROSLAVSKY, CHAIRMAN: BURKE MOVES, MOLINA SECONDS.

3 UNANIMOUS VOTE.

5 CLERK SACHI HAMAI: INTERNAL SERVICES, ITEM 29.

7 SUP. YAROSLAVSKY, CHAIRMAN: MOLINA MOVES, KNABE SECONDS.

8 UNANIMOUS VOTE.

10 CLERK SACHI HAMAI: MENTAL HEALTH, ITEMS 30 THROUGH 32.

11

12 SUP. YAROSLAVSKY, CHAIRMAN: BURKE MOVES, KNABE SECONDS.
13 UNANIMOUS VOTE.

14

15 CLERK SACHI HAMAI: PARKS AND RECREATION, ITEMS 33 AND 34.
16

17 SUP. YAROSLAVSKY, CHAIRMAN: MOLINA MOVES, BURKE SECONDS.
18 UNANIMOUS VOTE.

19

20 CLERK SACHI HAMAI: PROBATION, ITEM 35.

21

SUP. YAROSLAVSKY, CHAIRMAN: MOLINA MOVES, KNABE SECONDS,

UNANIMOUS VOTE.

CLERK SACHI HAMAI: PUBLIC LIBRARY, ITEM 36.
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SUP. YAROSLAVSKY, CHAIRMAN: KNABE MOVES, BURKE SECONDS.

UNANIMOUS VOTE.

CLERK SACHI HAMAI: PUBLIC WORKS, ITEMS 37 THROUGH 58.

SUP. YAROSLAVSKY, CHAIRMAN: KNABE MOVES, BURKE SECONDS.

UNANIMOUS VOTE.

CLERK SACHI HAMAI: ON PAGE 28, SHERIFF, ITEM 59.

SUP. YAROSLAVSKY, CHAIRMAN: BURKE MOVES, MOLINA SECONDS.

UNANIMOUS VOTE.

CLERK SACHI HAMAI: ORDINANCES FOR ADOPTION, ITEMS 60 AND 61.
ON ITEM 60, THIS ALSO INCLUDES SUPERVISOR ANTONOVICH'S
AMENDMENTS AS INDICATED ON THE SUPPLEMENTAL AGENDA. AND ALSO
SUPERVISOR KNABE, SUPERVISOR ANTONOVICH AND A MEMBER OF THE

PUBLIC REQUEST THAT THIS ITEM BE HELD.

SUP. YAROSLAVSKY, CHAIRMAN: IT WILL BE HELD.

CLERK SACHI HAMAI: MISCELLANEOUS COMMUNICATIONS, ITEMS 62

THROUGH 69. ON ITEM 65, SUPERVISOR MOLINA APPROVES THE
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1 SETTLEMENT AGREEMENT BUT REQUESTS THAT THE CORRECTIVE ACTION

2 BE CONTINUED FOUR WEEKS TO APRIL 17, 2007.

4 SUP. YAROSLAVSKY, CHAIRMAN: ALL RIGHT. WITH THAT

5 UNDERSTANDING, MOLINA MOVES, BURKE SECONDS. UNANIMOUS VOTE.

7 CLERK SACHI HAMAI: I'M SORRY. CAN WE GO BACK TO ITEM 617 WE

8§ NEED APPROVAL ON THAT ITEM.

10 SUP. YAROSLAVSKY, CHAIRMAN: SORRY ABOUT THAT. 61.

11

12 CLERK SACHI HAMAI: THAT WAS UNDER THE SECOND ORDINANCE.

13

14 SUP. YAROSLAVSKY, CHAIRMAN: YES. BURKE MOVES, KNABE SECONDS.
15 UNANIMOUS VOTE.

16

17 CLERK SACHI HAMAI: GREAT. THANK YOU. WE ARE ON MISCELLANEOUS,
18 ADDITIONS TO THE AGENDA REQUESTED BY BOARD MEMBERS AND THE
19 CHIEF ADMINISTRATIVE OFFICER WHICH WERE POSTED MORE THAN 72
20 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE GREEN

21 SUPPLEMENTAL AGENDA. ITEM 70A.

SUP. YAROSLAVSKY, CHAIRMAN: MOLINA MOVES, BURKE SECONDS.

UNANIMOUS VOTE.
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1 CLERK SACHI HAMAT: 70B.

3 SUP. YAROSLAVSKY, CHAIRMAN: ANTONOVICH MOVES, BURKE SECONDS,

4  UNANIMOUS VOTE.

6 CLERK SACHI HAMAI: 70C.

8 SUP. YAROSLAVSKY, CHAIRMAN: ANTONOVICH MOVES, MOLINA SECONDS.
9 UNANIMOUS VOTE.

10

11 CLERK SACHI HAMAI: ON ITEMS CONTINUED...

12

13 SUP. YAROSLAVSKY, CHAIRMAN: EXCUSE ME. ANTONOVICH IS NOT IN
14 THE ROOM.

15

16 CLERK SACHI HAMAI: HE'S NOT HERE.

17

18 SUP. YAROSLAVSKY, CHAIRMAN: SO ON 70A AND 70B, BURKE MOVES AND
19 KNABE SECONDS, UNANIMOUS VOTE ON BOTH OF THOSE. AND, ON 70C,
20 BURKE MOVES IT AND KNABE SECONDS. UNANIMOUS VOTE.

21

22 CLERK SACHI HAMAI: ON ITEMS...

SUP. MOLINA: ON ITEM NUMBER 12, COULD WE RECONSIDER THAT? I'D

LIKE TO ASK SOME QUESTIONS.
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SUP. YAROSLAVSKY, CHAIRMAN: SURE. WITHOUT OBJECTION, MOLINA
MOVES, I'LL SECOND, MOTION TO RECONSIDER ITEM 12. IT'S BEFORE

US AND WE'LL HOLD IT FOR DISCUSSION. ANYTHING ELSE?

CLERK SACHI HAMAI: YES. ON ITEMS CONTINUED FROM PREVIOUS
MEETINGS FOR FURTHER DISCUSSION AND ACTION BY THE BOARD, ON
ITEM A-3, THE DIRECTOR OF HEALTH SERVICES IS REQUESTING TO

HOLD THIS ITEM FOR A REPORT.

SUP. YAROSLAVSKY, CHAIRMAN: OKAY. GO AHEAD.

CLERK SACHI HAMAI: THAT COMPLETES THE READING OF THE AGENDA.
BOARD OF SUPERVISORS' SPECIAL ITEMS BEGIN WITH SUPERVISORIAL

DISTRICT NUMBER 1.

SUP. YAROSLAVSKY, CHAIRMAN: OKAY. IF THERE'S, IF THERE'S,
AFTER WE DO THE PRESENTATIONS, IF THERE'S NO OBJECTION, I KNOW
YOU'RE UP FIRST BUT I'D LIKE TO ASK DR. CHERNOF TO GIVE HIS A-
3 REPORT FIRST IN THE INTEREST OF HIS TIME. ALL RIGHT. THEN,
DAVID, IF YOU'LL LET DR. CHERNOF KNOW THAT HE'LL BE UP FIRST
AFTER THE PRESENTATIONS. ALL RIGHT. THANK YOU. SO WE'RE DONE
WITH THE CONSENT CALENDAR. WE HAVE THE AGENDA-- THE
PRESENTATIONS. AM I UP FIRST FOR THE STARS OR DO I DO THAT IN

ORDER?
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CLERK SACHI HAMAI: THE STARS IS UP FIRST.

SUP. YAROSLAVSKY, CHAIRMAN: OKAY. AND THEN MS. MOLINA. YEAH.
NO PROBLEM. ALL RIGHT. YOU'LL BE UP-- WHY DON'T I JUST

RECOGNIZE YOU NOW. SUPERVISOR BURKE FOR A PRESENTATION.

SUP. BURKE: I'D LIKE TO CALL FORWARD JUDGE KELVIN D. FILER.
JUDGE FILER HAS BEEN SELECTED AS THIS YEAR'S UNIVERSITY OF
CALIFORNIA SANTA CRUZ DIVISION OF SOCIAL SCIENCES AS THE
SOCIAL SCIENCE RECIPIENT OF THE DISTINGUISHED SOCIAL SCIENCE
ALUMNI AWARD. HE RECEIVED HIS B.A. IN POLITICS FROM
STEVENSON'S COLLEGE BEFORE MOVING ON TO BOALT SCHOOL OF LAW AT
U.C. BERKELEY. FOR OVER 25 YEARS, HE'S BEEN MAKING HIS MARK IN
THE COURTS AND IS KNOWN FOR DISPENSING JUSTICE WITH INTEGRITY
AND COMPASSION. HE SPENT TWO YEARS IN THE STATE PUBLIC
DEFENDERS OFFICE BEFORE ESTABLISHING A PRIVATE PRACTICE IN
COMPTON. HIS LANDMARK CASE, WHICH HE ARGUED BEFORE THE SUPREME
COURT, ESTABLISHED THE RIGHT OF THE ACCUSED TO WEAR STREET
CLOTHES IN COURT RATHER THAN JAIL BLUES, WHICH MIGHT PREJUDICE
JURORS. HE IS A TREMENDOUS ROLE MODEL AND DEEPLY INVOLVED IN
HIS COMMUNITY. HE GOES TO SCHOOLS WEEKLY TO ENCOURAGE STUDENTS
TO WORK HARD AND FOLLOW THEIR DREAM. AND CERTAINLY WE KNOW
THAT HE COMES FROM A FAMILY OF LAWYERS. HIS DAD-- I SHOULDN'T

SAY THIS BUT HIS DAD TOOK THE BAR HOW MANY TIMES?
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JUDGE KELVIN FILER: 48.

SUP. BURKE: 48 TIMES AND HE BECAME A LAWYER, SO HIS DAD REALLY
WANTED TO SHOW HIM THAT IT'S IMPORTANT TO REALLY PERSEVERE. OF
COURSE, HE WENT THROUGH WITH FLYING COLORS AND NEVER HAD A
PROBLEM FIRST TIME BUT HIS DAD ESTABLISHED REALLY AN
ENCOURAGEMENT TO HIM AND IT'S A FAMILY THAT'S MADE GREAT
CONTRIBUTIONS AND HE HAS CONTINUED TO CONTRIBUTE SO MUCH TO
HIS COMMUNITY. WE'RE VERY PLEASED TO PRESENT THIS RECOGNITION.

[ APPLAUSE ]

JUDGE KELVIN D. FILER: JUST ON BEHALF OF THE COMPTON
COMMUNITY, BECAUSE I ALWAYS FEEL LIKE I'M REPRESENTING COMPTON
ANY TIME I RECEIVE ANY TYPE OF ACKNOWLEDGEMENT, I'D LIKE TO
THANK THE BOARD OF SUPERVISORS, AND PARTICULARLY THANK
SUPERVISOR BURKE. SHE NOT ONLY HAS OPENED THE DOORS FOR
INDIVIDUALS SUCH AS MYSELEF BUT SHE STAYED THERE AND HELD IT

OPEN FOR US. THANK YOU VERY MUCH. [ APPLAUSE ]

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. IT'S A PLEASURE FOR ME
TO NOW INTRODUCE THE MARCH 2007 L.A. COUNTY STARS. FIRST IN
THE CATEGORY OF WORKFORCE EXCELLENCE-- OH, HERE COME THE
STARS. IT'S A PLEASURE TO INTRODUCE THE LOS ANGELES COUNTY

LEARNING ACADEMY. UNDER THE DIRECTION OF THE DEPARTMENT OF
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HUMAN RESOURCES, ORGANIZATIONAL AND EMPLOYEE DEVELOPMENT

DIVISION... [ APPLAUSE ]

SUP. YAROSLAVSKY, CHAIRMAN: ...ALONG WITH COLLABORATING COUNTY
DEPARTMENT REPRESENTATIVES FROM THE C.A.O., I.S5.D., AUDITOR-
CONTROLLER, COUNTY COUNSEL AND THE EXECUTIVE OFFICE OF THE
BOARD. WE ALSO HAVE WITH US ACADEMIC PARTNERS FROM THE L.A.
UNIFIED SCHOOL DISTRICT, LOS ANGELES VALLEY COLLEGE, LOS
ANGELES CITY COLLEGE, CAL STATE NORTHRIDGE AND CAL STATE
DOMINGUEZ HILLS. THE ACADEMY WAS CREATED IN A STRATEGIC
APPROACH TO MEET THE MANY EMERGING EMPLOYEE DEVELOPMENT NEEDS
OF THE COUNTY'S LARGE AND DIVERSE WORKFORCE AND PARTICULARLY
TO ADDRESS THE DEVELOPMENT OF MANAGERS AND EXECUTIVES IN
SUPPORT OF SUCCESSION PLANNING. IT BEGAN WITH A FEW PROGRAMS--
BEGAN WITH A FEW PROGRAMS AND HAS GROWN TO INCLUDE MORE THAN
15 CERTIFICATE PROGRAMS AND OVER 20 WORKSHOPS. THE ACADEMY IS
UNIQUE BECAUSE OF THE PUBLIC PARTNERSHIP THAT HAS FORGED
BETWEEN THE COUNTY AND THE CAL STATE UNIVERSITY SYSTEM, THE
COMMUNITY COLLEGES AND THE L.A. UNIFIED SCHOOL DISTRICTS. WE
WANT TO CONGRATULATE EVERYONE INVOLVED WITH THE LOS ANGELES
COUNTY LEARNING ACADEMY FOR THE GREAT WORK THEY'RE DOING. IT
STARTED AS A SMALL IDEA AND HAS GOTTEN TO BE A BIG IDEA AND
IT'S SERVING THE NEEDS OF THIS COUNTY EXTREMELY WELL.

CONGRATULATIONS. [ APPLAUSE ]
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1 SUP. YAROSLAVSKY, CHAIRMAN: OUR NEXT RECIPIENT, ALSO FOR
2  WORKFORCE EXCELLENCE, IS JULIE VALDEZ, A LICENSED CLINICAL
3 SOCIAL WORKER FROM THE DEPARTMENT OF MENTAL HEALTH. [ APPLAUSE

4 ]

6 SUP. YAROSLAVSKY, CHAIRMAN: GIVE HER A HAND. [ APPLAUSE ]

8 SUP. YAROSLAVSKY, CHAIRMAN: JULIE IS RESPONSIBLE FOR THE

9 ACCESS CENTER, THE ENTRY POINT FOR MENTAL HEALTH SERVICES

10 HANDLING 220,000 CALLS ANNUALLY AND FUNCTIONS AS A BACKUP

11 DISASTER COMMAND CENTER FOR THE NATIONAL HOTLINE. SHE HAS BEEN
12 ACTIVELY INVOLVED IN THE IMPLEMENTATION OF THE 2-1-1 SYSTEM

13 AND HAS SET UP A STATE MANDATED HOTLINE FOR SPECIALIZED FOSTER
14 CARE CONSUMERS. SHE LEADS, MOTIVATED AND WORKS COHESIVELY WITH
15 HER STAFF, PROMOTING A COMFORTABLE ORGANIZATIONAL ATMOSPHERE
16 AND APPRECIATES THE EFFORTS OF HER MULTILINGUAL AND

17  MULTIDISCIPLINARY STAFF TO ENSURE THAT OUR DIVERSE CLIENTELE
18 RECEIVES PROPER ASSISTANCE. CONGRATULATIONS, JULIE, AND THANK
19 YOU FOR YOUR LEADERSHIP AND YOUR DEDICATION. [ APPLAUSE ]

20

21 SUP. YAROSLAVSKY, CHAIRMAN: NEXT, IN THE CATEGORY OF FISCAL

22 RESPONSIBILITY, IT'S A PLEASURE TO INTRODUCE THE CLAIMS AND
LITIGATION SECTION OF THE DEPARTMENT OF PUBLIC WORKS. THIS
SECTION PROCESSES PROPERTY DAMAGE AND/OR PERSONAL INJURY

CLAIMS AND ASSISTS COUNSEL IN LITIGATION AGAINST THE COUNTY

The Meeting Transcript of
The Los Angeles County Board of Supervisors
17




The Los Angeles County Board of Supervisors

March 20, 2007

The Meeting Transcript of

10

11

12

13

14

15

16

17

18

19

20

21

THROUGH THE DEPARTMENT OF PUBLIC WORKS. OVER THE PAST THREE
YEARS, THEY HAVE PROCESSED AN AVERAGE OF 700 CLAIMS PER YEAR.
MOREOVER, THEY HAVE REDUCED THE COSTS ASSOCIATED WITH CLAIMS
AND LITIGATION BY UTILIZING INFORMATIONAL TECHNOLOGIES,
INVESTIGATING CLAIMS WITH THE EXPECTATION OF LITIGATION AND
RETAINING COUNCIL AT THE EARLIEST STAGES. IT'S SAVED US A
CONSIDERABLE AMOUNT OF TAXPAYERS' MONEY AND WE WANT TO
CONGRATULATE ALL THE PEOPLE INVOLVED IN THE CLAIMS AND
LITIGATION SECTION OF THE DEPARTMENT OF PUBLIC WORKS. [

APPLAUSE ]

SUP. YAROSLAVSKY, CHAIRMAN: LET'S HEAR IT FOR ALL OF OUR
STARS. OKAY. NEXT, SUPERVISOR BURKE, YOU'LL-- YOU'RE NEXT AND

THEN I'LL COME BACK FOR MY OTHER PRESENTATIONS.

SUP. BURKE: (OFF-MIKE) .

SUP. YAROSLAVSKY, CHAIRMAN: SHE HAS NO PRESENTATIONS.

SUP. BURKE: WELL, I THINK THAT SHE'S GOING TO COME UP HERE. WE
HAVE A CENTENARIAN. EMMA JACKSON IS GOING TO COME UP. OKAY.
I'M GOING TO JUST START TO GIVE YOU SOME INTRODUCTION WHILE
SHE'S COMING UP. EMMA JACKSON WAS BORN IN 1905 AND SHE'S A
VIBRANT, 102-YEAR-OLD CENTENARIAN. SHE'S THE ELDEST OF SIX

CHILDREN, ALL OF WHICH ARE STILL LIVING. SHE STILL MAINTAINS
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1 AND BALANCES HER CHECKBOOK, IS AN ACTIVE MEMBER OF THE

2 WASHINGTON IRVING LIBRARY AND LOVES TO TRAVEL, VISITING HER

3 SISTERS IN DETROIT, CLEVELAND AND ALABAMA. SHE'S KNOWN AS AN
4 EXPERT SEAMSTRESS AND EXCELS AT KNITTING AND CROCHETING, IN

5 ADDITION TO MAKING BEAUTIFUL QUILTS. MOST IMPRESSIVE IS THAT
6 SHE RECENTLY BEGAN AN ACTING CAREER, RECENTLY AUDITIONING TO
7 APPEAR IN COMMERCIALS. SO IT'S WITH GREAT PLEASURE THAT WE

8 CELEBRATE HER BIRTHDAY AND RECOGNIZE EMMA CARR JACKSON, 105!
9 I'M SORRY. 102! 102! BORN IN 1905. 102. [ APPLAUSE ]

10

11 SUP. BURKE: CONGRATULATIONS TO YOU. PLEASE SAY A WORD FOR US.
12

13 EMMA JACKSON: THANK YOU.

14

15 SUP. BURKE: I'M GOING TO LIFT THIS OUT SO IT WILL BE CLOSER TO
16 HER. THAT SHOULD BE BETTER.

17

18 EMMA JACKSON: GOOD MORNING, EVERYBODY. I AM VERY THANKFUL TO
19 BE HERE. I APPRECIATE VERY MUCH THE INVITATION TO HAVE ME

20 HERE. I THANK YOU. AND THE PROGRAM SAYS EVERYTHING I COULD

21 TELL YOU. <LAUGHTER>

22

23 SUP. BURKE: WELL, WE HAVE A QUILTER HERE. SUPERVISOR GLORIA
24  MOLINA IS ANOTHER QUILTER. I QUILT A LITTLE BIT BUT SHE'S A

25 REAL QUILTER. YOU DO QUILTING AND KNITTING, RIGHT?
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EMMA JACKSON: RIGHT. CROCHETING AND KNITTING AND MAKING
QUILTS. AND MY OCCUPATION IS DRESS MAKING. YES, I'M A RETIRED

DRESS MAKER.

SUP. BURKE: NOW AN ACTRESS, RIGHT? WELL, MANY HAPPY RETURNS
AND MANY MORE IN YOUR FUTURE. AND WHO DO YOU HAVE HERE WITH

YOU?

EMMA JACKSON: MY THREE SONS. JOHN, DAVID AND CARL BUT THIS IS

THE OLDEST AND THEY GO THAT WAY. [ LAUGHTER ]

SUP. BURKE: WELL, HAPPY, HAPPY BIRTHDAY.

EMMA JACKSON: THANK YOU AND THANK EVERYONE. [ APPLAUSE ]

SUP. BURKE: THANK YOU. THAT CONCLUDES MY PRESENTATIONS.

SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. I HAVE A COUPLE
PRESENTATIONS. FIRST, I'D LIKE TO ASK LEONARD SCHNEIDERMAN TO
COME FORWARD. IT'S A PRIVILEGE TO HAVE DR. LEONARD
SCHNEIDERMAN THIS MORNING. WE WANTED TO HONOR HIM FOR NO
PARTICULAR REASON. IT'S NOT HIS BIRTHDAY, HE'S NOT RETIRING
BUT HE HAS BEEN SUCH A GREAT ASSET TO THIS COUNTY AND TO THIS

COMMUNITY THAT WE WANTED TO TAKE THIS OPPORTUNITY TO HONOR
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1 HIM. LEONARD SCHNEIDERMAN SERVED AS THE DEAN AND PROFESSOR OF
2 U.C.L.A. SCHOOL OF SOCIAL WELFARE FROM 1983 TO '93, AS A

3 CONSULTANT TO THE CALIFORNIA LEGISLATURE'S COMMITTEES ON

4 HEALTH AND HUMAN SERVICES FROM 1985 TO '91, AS PROFESSOR

5 EMERITUS AT U.C.L.A.'S SCHOOL OF PUBLIC POLICY FROM 1993 TO
6 THE PRESENT AND IS CURRENTLY A VISITING PROFESSOR AT BEN-

7 GURION UNIVERSITY IN ISRAEL. HE IS A DISTINGUISHED SCHOLAR AND
8 ADVOCATE WHO HAS WORKED TIRELESSLY TO IMPROVE THE SOCIAL

9 SERVICE SYSTEM AND WELLBEING OF CHILDREN AND FAMILIES IN LOS
10 ANGELES COUNTY AND I WOULD SAY THROUGHOUT THE STATE OF

11 CALTFORNIA AND HAS EXTENSIVELY STUDIED INDIVIDUAL AND FAMILY
12 POVERTY, THE EFFECTIVENESS OF PUBLIC POLICY AND PROGRAM

13 RESPONSES TO POVERTY AND THE DIFFERENTIAL ROLE OF SOCIAL

14 WELFARE POLICIES AND PROGRAMS IN FIRST AND THIRD WORLD

15 COUNTRIES. DR. SCHNEIDERMAN PROVIDED GUIDANCE AND LEADERSHIP
16 ON VARIOUS COMMITTEES, INCLUDING THE CALWORKS SANCTIONED

17 ACTION PLAN PARTNERS WORKGROUP, THE C.I.M.H. IMPLICATIONS

18 WORKGROUP, COMMITTEE ON REVIEW AND EVALUATION OF CALWORKS AND
19 THE BLUE RIBBON TASK FORCE ON HOMELESSNESS. HE'S SUCCESSFULLY
20 ADVOCATED FOR RESEARCH AND IMPROVEMENT IN THE AREAS OF

21 SANCTIONS AND SUPPORTIVE SERVICES. HIS EXEMPLARY LEADERSHIP
22 HAS MADE A LASTING CONTRIBUTION TO IMPROVING THE LIVES OF
DISADVANTAGED FAMILIES. HIS PERSISTENCE, INCISIVE ANALYTICAL
SKILLS, KNOWLEDGE AND EXPERIENCE HAS INFLUENCED NUMEROUS

D.P.5.5. PROGRAMS INCLUDING SANCTIONS, EMPLOYMENT, SUPPORTIVE
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SERVICES AND FRAUD. HE HAS BEEN MY COMMISSIONER ON THE

D.P.S.S. COMMISSION I THINK SINCE I TOOK OFFICE HERE IN 1994.
SO THE BOARD OF SUPERVISORS WANTED TO TAKE THIS OPPORTUNITY,
LEONARD, TO HONOR YOU AND TO COMMEND YOU FOR YOUR OUTSTANDING
AND DEDICATED SERVICE TO THE COUNTY, THE FAMILIES THAT THE
COUNTY SERVES. I WOULD ADD ONE OTHER THING IS HE'S AN AVID
U.C.L.A. BASKETBALL FAN AND I KNOW WHAT A SACRIFICE THIS IS
FOR YOU TO COME HERE DURING SWEET 16 WEEK BECAUSE I KNOW
YOU'RE WORKING OUT AND YOU'RE PREPARING AND SCOUTING THE
OPPOSITION. HE AND I SIT NOT FAR FROM EACH OTHER AT THE BALL
GAMES AND IT'S ANOTHER THING WE HAVE IN COMMON. LEONARD, YOU
HAVE BEEN A GREAT ASSET TO THE COUNTY, TO THE PEOPLE OF THE
COUNTY BUT ESPECIALLY TO ME AND MY OFFICE AND MY STAFF AND I
WANT TO THANK YOU FOR YOUR PARTNERSHIP AND FOR YOUR

FRIENDSHIP. CONGRATULATIONS. [ APPLAUSE ]

DR. LEONARD SCHNEIDERMAN: WELL, I WANT TO THANK THE BOARD FOR
THIS CITATION, RECOGNITION. I PARTICULARLY WANT TO THANK ZEV
FOR HIS CONFIDENCE IN APPOINTING ME AS HIS REPRESENTATIVE ON
THE COMMISSION. I WANT TO THANK ALL OF MY COLLEAGUES HERE.
CHAIRMAN DEBALAG, WHOSE LEADERSHIP TO THE COMMISSION HAS BEEN
OUTSTANDING AND WHO HAS BEEN VERY SUPPORTIVE IN ALL OF THE
ACTIVITIES WE'VE BEEN INVOLVED IN, ALL OF MY COWORKERS, IN
BEHALEF OF BETTER SOCIAL SERVICES FOR THE CITIZENS OF LOS

ANGELES COUNTY. LET ME JUST SAY TWO THINGS THAT I PARTICULARLY
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1 WANT TO CALL ATTENTION TO. ONE IS THE DEPARTMENT OF PUBLIC
2 SOCIAL SERVICES IS TRULY AN EXTRAORDINARY COUNTY DEPARTMENT.

3 WHEN ONE CONSIDERS THAT ALMOST 3 MILLION PEOPLE PER YEAR ARE

4 REPRESENTED IN THE CLIENTELE OF THAT ONE DEPARTMENT, 30% OF

5 THE POPULATION OF LOS ANGELES COUNTY, ONE CAN HARDLY

6 OVERESTIMATE THE IMPACT OF THAT DEPARTMENT. THE SECOND POINT I
7 WANT TO MAKE IS THAT THOSE THREE MILLION PEOPLE ARE KNOWN TO

8 OTHER DEPARTMENTS OF THE COUNTY AS WELL. THERE'S A LOT OF

9 INTERDEPARTMENTAL CROSSOVER, A GREAT NEED FOR SERVICE

10 INTEGRATION BETWEEN DEPARTMENTS IN ORDER TO ADDRESS THE

11 MULTIPLICITY OF NEEDS THAT THESE FAMILIES REPRESENT AND I WANT
12 PARTICULARLY TO COMMEND THE BOARD ON THE ACTION IT'S TAKEN TO
13 INTEGRATE THE SERVICE FUNCTIONS OF THE COUNTY WITHIN THE

14 C.A.0.'S OFFICE WITH A HOPE THAT THIS WILL REPRESENT A GIANT
15 STEP FORWARD, NOT ONLY IN ADMINISTRATIVE INTEGRATION BUT

16 SERVICE INTEGRATION SO THAT WE CAN DEVELOP INTERDEPARTMENTAL
17 APPROACHES TO THE NEEDS OF FAMILIES WHOSE NEEDS PUT THEM IN

18 TOUCH EVERYWHERE BUT THEY MAY EFFECTIVELY BE SERVED NOWHERE

19 BECAUSE NO ONE AUTHORITY HAS THE AUTHORITY AND THE ABILITY TO
20 RESPOND TO THEIR NEEDFULNESS. SERVICE INTEGRATION IS BADLY

21 NEEDED. I COMMEND THE BOARD FOR ITS ADMINISTRATIVE INTEGRATION
22 AND LOOK FORWARD TO THIS AS A GIANT STEP FORWARD IN
INTEGRATING SERVICES TO THE MOST VULNERABLE AND NEEDY FAMILIES

IN THIS COMMUNITY. SO THANK YOU, CHAIR. [ APPLAUSE ]
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1 SUP. YAROSLAVSKY, CHAIRMAN: THANK YOU. I'D LIKE TO ASK LYNDA
2 CASTRO TO COME FORWARD. THERE SHE IS. COMMANDER LYNDA CASTRO
3 CURRENTLY SERVES WITH DISTINCTION AS A COMMANDER IN THE LOS
4 ANGELES COUNTY SHERIFF'S DEPARTMENT, A POSITION SHE HAS HELD
5 SINCE JULY 2003. SHE PREVIOUSLY SERVED IN A WIDE VARIETY OF
6 ASSIGNMENTS SINCE JOINING THE DEPARTMENT IN 1977, INCLUDING
7 SERVICE IN THE SYBIL BRAND INSTITUTE, THE SHERIFF'S

8 INFORMATION, TRANSIT SERVICES AND RECRUIT TRAINING BUREAUS,
9 PITCHESS DETENTION CENTER, SOUTH FACILITY AND IN SEVERAL

10 STATIONS INCLUDING WEST HOLLYWOOD, WHERE I GOT TO KNOW HER.
11 THROUGHOUT HER CAREER, SHE HAS DEMONSTRATED A SPECIAL APTITUDE
12 FOR COMBINING HER COMMITMENT TO PROTECTING PUBLIC SAFETY WITH
13 AN ABIDING CONCERN FOR THE HUMAN RELATIONS ASPECTS OF THE LAW
14  ENFORCEMENT MISSION, A UNIQUE APPROACH THAT HAS BROUGHT HER

15 WELL EARNED RECOGNITION FOR HER EFFORTS. SHE'S RECEIVED

16 SPECIAL HONORS BY THE ANTI-DEFAMATION LEAGUE OF NARBERTH IN

17 THE PACIFIC SOUTHWEST REGION, WHICH CONFERRED UPON HER A

18 COVETED HELENE AND JOSEPH SHERWOOD PRIZE FOR COMBATING HATE,

19 AN AWARD RECOGNIZING LAW ENFORCEMENT PERSONNEL WHO MAKE A

20 SIGNIFICANT DIFFERENCE IN THEIR COMMUNITIES AND SERVE AS ROLE
21 MODELS FOR THEIR DEPARTMENTS, GOING BEYOND THE CALL OF DUTY IN
THEIR EFFORTS TO PROTECT THE COMMUNITY. SHE RESIDES IN HERMOSA
BEACH WITH HER HUSBAND, RICHARD, ALSO A COMMANDER IN THE LOS
ANGELES SHERIFF'S DEPARTMENT AND SHARES WITH HIM ENORMOUS

PRIDE IN A FAMILY THAT, BETWEEN THEM, NUMBERS FIVE GROWN
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1 CHILDREN AND FOUR GRANDSONS. THEY TAKE GREAT PLEASURE IN
2 LEISURE ACTIVITIES, SUCH AS RUNNING, READING AND TRAVELING.

3 THE BOARD OF SUPERVISORS OF THE COUNTY OF LOS ANGELES EXTENDS
4 SINCERE CONGRATULATIONS FOR THIS AWARD THAT YOU HAVE RECEIVED,
5 THE PRESTIGIOUS SHERWOOD AWARD, WITH BEST WISHES FOR CONTINUED
6 SUCCESS IN ALL YOUR FUTURE ENDEAVORS. LYNDA, YOU ARE A CLASS

7 ACT AND REALLY I CAN'T THINK OF ANYONE MORE DESERVING OF THIS
8 AWARD THAN YOU ARE. WE'VE ENJOYED WORKING WITH YOU, THE

9 PARTNERSHIP WE'VE HAD WITH YOU WHEN YOU WERE IN WEST HOLLYWOOD
10 BUT EVEN YOUR HIGHER-UP POSITIONS NOW, YOU'RE CARRYING ON THE
11 SAME LEVEL OF PROFESSIONALISM, PASSION AND HUMANITY THAT YOU
12 SHOWED IN WEST HOLLYWOOD, SO I WANT TO PERSONALLY CONGRATULATE
13 YOU AND THE BOARD DOES, TOO.

14

15 COMMANDER LYNDA CASTRO: THANK YOU VERY MUCH. I APPRECIATE IT.
16 [ APPLAUSE ]

17

18 COMMANDER LYNDA CASTRO: I'D JUST LIKE TO SAY THANK YOU VERY

19 MUCH NOT ONLY TO THE BOARD. I'VE BEEN ABLE TO SERVE IN ALL

20 FIVE DISTRICTS IN MY ASSIGNMENTS AT SEVEN DIFFERENT PATROL

21 STATIONS BUT IT'S BEEN AN HONOR TO SERVE ALL THE DIVERSE
COMMUNITIES AND I LOOK FORWARD TO CONTINUING TO SERVE AS THE
EQUITY COMMANDER FOR THE DEPARTMENT, PARTICULARLY THANKING MY
BOSS, UNDER-SHERIFF LARRY WALDY, WHO IS HERE WITH ME TODAY FOR

THAT ASSIGNMENT. THANK YOU, SIR.
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SUP. ANTONOVICH: I THINK WE SHOULD GIVE A COMMENDATION TO
UNDER-SHERIFF LARRY WALDIE, WHO HAS LOST 35 POUNDS.
CONGRATULATIONS. A GOOD ROLE MODEL FOR THE COUNTY. VERY GOOD.

CONGRATULATIONS, LARRY.

SUP. KNABE: HE SAID THAT WITH HIS GLASSES OFF, LARRY.

UNDER-SHERIFF LARRY WALDIE: I GAVE UP DRINKING AND MEAT.

SUP. YAROSLAVSKY, CHAIRMAN: HEH-HEH. ALL RIGHT. SUPERVISOR

KNABE.

SUP. KNABE: I'D LIKE TO CALL NANCY MAHR UP, COUNTY LIBRARIAN,
MARGARET TODD, CHIEF DEPUTY TOM MCGUIRE AND ASSISTANT DIRECTOR
OF PUBLIC SERVICES FOR THE LIBRARY, WENDY ROMANOW, TO ASK THEM
TO JOIN ME UP HERE. ALL RIGHT. YOU CAN BE ON EITHER SIDE.
YOU'RE THE HONOREE. OBVIOUSLY, WE ARE VERY PLEASED TODAY TO
HONOR NANCY AND TO-- ON HER RETIREMENT AS WELL AS TO THANK
HER, FROM THE LOS ANGELES COUNTY PUBLIC LIBRARY. SHE HAS
SERVED AS OUR PUBLIC INFORMATION OFFICER FOR MORE THAN 10
YEARS. WE WERE COMMENTING UPSTAIRS IT'S UNIQUE TO SEE HER ON
THIS SIDE. USUALLY, SHE HAS A CAMERA IN HER HANDS ON THE OTHER
SIDE DOING HER THING. SHE'S HANDLED PRESS RELATIONS, LIBRARY

LEGISLATIVE ACTIVITIES AT BOTH THE STATE AND FEDERAL LEVELS,
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1 PUBLIC RELATIONS PROGRAMS, SUCH AS OUR BLACK HISTORY MONTH,
2 LIVING LEGENDS PROGRAM, OUR OPERA TALES, THE LIBRARY'S

3 PARTICIPATION IN THE "LOS ANGELES TIMES" FESTIVAL OF BOOKS AND
4 MANY OTHER EVENTS. IN ADDITION TO HER WORK WITH THE COUNTY

5 LIBRARY, SHE HAS BEEN AN ACTIVE COMMUNITY VOLUNTEER IN THE

6 FOURTH DISTRICT FOR OVER 35 YEARS. IN THE PAST, SHE HAS SERVED
7 ON THE BOARDS OF MANY ORGANIZATIONS, INCLUDING THE FRIENDS OF
8 THE LIBRARY AND PALOS VERDES, THE PALOS VERDES PENINSULA

9 COORDINATING COUNCIL, LEAGUE OF WOMEN VOTERS AND NUMEROUS

10 P.T.A.S DOWN THERE. SHE'S CURRENTLY A MEMBER OF THE PENINSULA
11 SYMPHONY ASSOCIATION, THE AMERICAN ASSOCIATION FOR UNIVERSITY
12 WOMEN AND SHE ALSO, IN HER OWN RIGHT, IS ELECTED AND IS VICE-
13 PRESIDENT OF THE PALOS VERDES LIBRARY BOARD OF TRUSTEES. SO WE
14 WANT TO THANK HER FOR HER MANY CONTRIBUTIONS TO THE CITIZENS
15 OF LOS ANGELES COUNTY ON BEHALF OF WHAT SHE'S DONE FOR THE

16 LIBRARY AND THE OUTREACH THAT SHE'S EXTENDED TO MAKE READING A
17 FUN KIND OF A THING AND ACCESS TO EVERYONE BUT ALSO TO THANK
18 HER FOR HER MANY YEARS OF VOLUNTEER SERVICE BUT, AS I SAID

19 UPSTAIRS, SHE MAY BE RETIRING FROM THE COUNTY BUT WE KNOW THAT
20 WE WILL SEE HER IN MANY OTHER ORGANIZATIONS BECAUSE SHE IS A

21 GREAT PUBLIC SERVANT. CONGRATULATIONS, NANCY. [ APPLAUSE ]

SUP. BURKE: MR. CHAIR, I WOULD JUST LIKE TO JOIN IN THANKING
HER. THANK YOU, NANCY, FOR ALL YOUR HARD WORK. I KNOW THAT

SOME OF OUR EVENTS ARE VERY TRYING AND STRESSFUL BUT WE'VE
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